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Welcome to the Portable Design Quick Reference 
 

This manual provides you with instructional and reference material to help you get  
started easy with Portable Design.  Use it initially to learn the basics of Portable 
Design. For specific tasks, use the Portable Design Manual, witchl covers all 
available options in our software. 
 
This guide is not intended as a manual on how to use your computer, rather as a 
manual on using the Portable Design System.  If you are new to computers, read the 
documentation that came with your computer for instructions on setting it up and 
using it.  At the very minimum you should be familiar with working in a graphical 
environment, using a mouse, selecting commands from menus, etc.  Keyboard skills 
are not required, but will enhance your speed on the system. 
  
 
For further assistance, please contact Expolinc: 
 
Phone: +46 8 546 444 00 
Fax: +46 8 29 10 06 
Email: info@expolinc.com  
Web: http://www.expolinc.com 
           
Information contained in this document is subject to change without notice and does 
not represent a commitment on the part of Expolinc AB.  The software, which 
includes information contained within any database, described in this documentation, 
is furnished under a license agreement and may be used or copied only in 
accordance with the terms and conditions of the agreement.  It is against the law to 
copy the software on any medium except as specifically allowed by Expolinc AB or in 
the license agreement. 
 
This document is copyright .  All rights reserved. 
 
No part of this publication may be reproduced or transmitted in any form by any 
means including but not limited to electronic or mechanical, photocopy, recording, or 
any information storage and retrieval system, without permission in writing from 
Expolinc AB.  Requests for permission to reproduce any or all of this publication 
should be sent to: 
 
Expolinc AB       Phone: +46 8 546 444 00 
Portable Design                 Fax: +46 8 29 10 06 
Industrivägen 7      Email: info@expolinc.com  
S-171 48  SOLNA 
Sweden 
 
 
 
 
 
 
 
Microsoft is a registered trademark, and Windows is a trademark of Microsoft 
Corporation. Epson is a trademark of Epson 
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Starting Portable Design 
  

Move the mouse pointer over the Portable Design icon and double click. 
 

 

 
OR 

 
Move the mouse pointer over the Start button on the toolbar and click, a 
menu will appear, click Programs, then from the cascading menus click 
Portable Design then Portable Design 

 
 

 
This has now started Portable Design.  
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Create a New Design 
 
 
New 
 
 
 
Choose New from the File menu. 
 
 
Name the design and click Save. 
        
 
 
 
 
 
 
 
 
This brings up the wall layout, with the most common roomconfigurations. 
 
       
  
 
 
 
 
 
 
• Select the desired layout and click Next. 
 
 
 
 
 
 
 
 
 
 
• Enter the desired dimensions.   
     You may use the TAB key to move  
      to a new field. 
 
 
 
 
 
• Click Finish to place the walls in the room. 
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Change Default Style 
 
The Change Default Style command is chosen to change the default settings for 
inc. the walls and the floor in a design. 
 
You can now select colours for the walls an floor in your design. 
Of course you can change the colours later. 
 
 

• Under the headline Wall, highlight the 
Wall. 

 
• Select colour from the menu. 

 
• Under the headline Floorl, highlight the 

Floor. 
 

• Select colour from the menu. 
 

• Click OK. 
 
 
 
 
 
Now you should see this on your screen. 
Now you are ready to place the systems in to the design.
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Graphical Add Palette 
 
Choose the Graphical Add tool. 
 
 
The Graphic Add Palette is a “drag and drop” planning facility. 
 
Units to be shown can be selected by using these  
two buttons: 
 
 
 
 
Units in the catalogue: 
 
 
 
 
 
 
 
 
 
 
 
 
 
Currently selected unit: 
 
 
 
 
 
 
 
 
Dimensions and Handing: 
 
 
 
As in the standard Add Palette, it is possible to select the unit that is required by 
typing the unit name into the Graphic Add palette.  However, instead of positioning 
the cursor on the plan, then adding the unit into the plan, using the Graphic Add 
Palette it is possible to “Drag and Drop” the unit into the plan. 
 
1) Move the mouse cursor over the required unit. 
2) Hold down the left mouse button. 
3) Keeping the left mouse button held down, drag the mouse from the Graphic Add 

Palette into the Plan. 
The Unit can be seen dragging into the Plan, simply drag the unit into the required 
position, then release the mouse button.  The unit will snap to walls and other units, 
once in the plan the unit can be moved by dragging, or by using the mover palette. 
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Start to drag in the Lighting somwere at the 
design. 
 
Then add the Floor. 
 
 
 
 
 
 
 
 
 
Tip. 
Leave the Floor Highlighted.  
 
Choose the Mover Mode. 
 
Click on the Backward arrow.  
 
Accept the value by click OK. 
 
 
 
 
 
 
 
 
Click the Left arrow.  
 
Accept the value by click OK. 
 
 
 
Now you are shure the floor is right posisoned in the 
upper left corner. 
 
 
 
 
 
 
Now choose the Info Mode.  
 
Set the Length and Depth to the same values as the Walls. 
 
 
 
 
 
 
Now the Floor covers the complet area corresponding to the 
edges of the Walls. 
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Now continue with for inc a Pop-Up 3x3 system. 
 
Go back to the Graphical Add Mode. 
 
 
Look for the Pop-Up System in the Graphical Add 
Mnu and dragit to the design. 
 
Now you have a chose of Assessories. 
 
If you want a Shelf. Click the left arrow. 
 
Click OK 
 
 
If you want to rotate the system do as follow: 
 
Highlight the system you want to rotate. 
 
Rightclick on the system.   
 
Select Free Rotation from the menu. 
 
Select Current Selection. 
 
 
The cursor will display a circular object notifying you that you are in rotation mode.  
All you have to do is move your mouse clockwise or counter clockwise.  Click the left 
mouse button to stop the rotation. 
 
 
Holding the Control key down while rotating will force the 
object to snap to the preset snapping angle (45° By 
default). 
 
Holding the Shift key down while rotating will indicate the 
front of the object with a blue line. 
 
 
 
Let´s have a look at this in Perspective.  
 
Choose Perspective from View menu. 
 
Choose the View Mode 
 
 
Click Default View. 
 
 
Click somwere outside the designarea to 
unselect all items. 
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Perspective View Palette 
 
 
The Perspective View draws a three-dimensional view of the design.  The 
Perspective View Palette contains all the necessary controls for adjusting the 
perspective view. 
 
          
 
The Named Views and Render Settings are discussed 
previously in this chapter under General View Palette 
Functionality. 
 
Controlling the Perspective View 
 
The middle of the view palette displays a miniature drawing of 
the plan.  Superimposed on this drawing are several lines. 
 
The apex of the two long lines (called the view lines) is marked 
by a small circle.  This circle is referred to as the eye point and 
is the point the view is taken from. 
 
Another line extends from the eye point dissecting the angle 
between the two view lines.  The end of this line is marked by a 
cross.  This cross is referred to as the focus point and is the 
point at which the eye is looking. 
 
Portable Design draws the perspective view of the room as if 
you were standing at the eye point looking towards the focus 
point. 
 

Perspective View Palette 
The view lines mark the field of vision, i.e. how much you see of 
the room.  The wider the angle between the view lines, the more 
of the design will be seen. 
 
In Portable Design, you control the focus point with the right mouse button.  
Clicking anywhere in the miniature plan with the right button will set the focus point to 
the point clicked. 
 
You control the eye point with the left mouse button.  Clicking anywhere in the 
miniature plan with the left mouse button will set the eye point to the point clicked. 
 
The Field of Vision can be changed by depressing the SHIFT key on the keyboard 
while clicking the mouse button.  This will change the angle between the two view 
lines so that one of the view lines will pass through the point clicked. 
 
The Heights of the eye and focus points can be changed using the scroll bars on 
either side of the plan drawing.  The left scroll bar controls the height of the eye 
point. The right scroll bar controls the height of the focus point.  Moving the thumb 
of the scroll bar up will raise the height, and moving the thumb down will lower it. 
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Render Settings 
 
The two View Palettes (Plan and Perspective) have several common functions to 
define the rendering method used.  The discussion here relates to all views. 
 
The Render Settings determine how Portable Design draws the current view.  
 
The different choices have an effect on speed of drawing to the screen and printing.  
The simpler the option, the quicker the drawing. 
 
 
Choosing a Render Setting 
 
To apply a render setting to the current view, do the following: 
 
• Display the View Palette. 

• Select Render Settings. 

• Choose an option from the menu. 
 
 

Choosing an Option From the Render Settings Menu 
 
 
Portable Design will redraw the view using the chosen render setting. 
 
Should you wish to halt a render half way through, right click in the planning area.  A 
box will appear, giving the option of “Continue” or “Stop”.  Clicking on “Continue” will 
allow the rendering to continue, clicking on “Stop” will stop the current render, and 
display the design in Wireframe render. 
 
Wire frame is the fastest, but least realistic rendering mode.  It draws all lines of all 
objects in the design. 
 
 
  
 
 
 
 
 

 
 

Wire frame perspective 
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Draft is flat colour rendering showing no lighting effects. 
 
      

 
 
 
 
 
 
 
 
 

 
 

Draft Perspective 
OpenGL showing graphics, wood grains, textures in low resolution. No lighting 
shadows, and reflections effects. 
 

 
               OpenGL  
 
Photo is full photo realistic rendering showing lighting effects, wood grains, textures, 
shadows, and reflections.  This is the highest level of rendering. 
 

     
 

Photo Perspective 
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Creating a Named View 
 
To name the current view, do the following: 
 
• Display the View Palette.  

• Click the arrow beside the Named Views field. 

• Choose <Define…> from the menu. 
 

 
The Named Views Dialog appears: 
 
The field at the top allows you to name the render 
setting.  Click in the field and type a name for the 
setting. 
 
                                                                               
The Define for New Rooms checkbox allows you 
to save the named view in preferences so 
that it is available in all new designs. 
                                                                              
Named Views Dialog 
 
 
 
Multi-View 
 
It is possible to print off upto 4 named views on one page.  This is achieved by using 
the multi-view function. 
 
Firstly, you will need to set up the named views that you wish to see in the multi-view.  
These named views can be set up from either Plan or Perspective. 
 
Then click on “View, Multiview”. 
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This opens the Multi-View screen. 
 
 
 
 
 
 
 
 
 
 
By clicking on the Pop-up menus it is possible to select which named view you wish 
to see in each viewing pane (top left, top right etc). 
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Add customized Images to Portable Design 
 

• Close every Rom file.  
 

• Display the File menu. 
 

• Coose Image Container. 
 

 
• Click Manager 
 
 
• Click Add 

 
You can import any JEPG 
graphics to Portable Design such 
as scanned images, digital pohtos 
and downloded images from 
website.  

 
 
 
Now you can look for your images.  
 

• Highlight the desired 
      image and click Open 
 

 
 
 
 
 
 
 
 
Now you can se the image listed in the 
image window. 
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To change graphic to one of the systems, do the following: 
 
• Highlight the system by 

leftclick, 
 
• Rightclick over the 

highlighted system. 
 
• Select the system in the 

menu. 
 
 
 
 
 
 
 
 
 
• Double click on  
     Change FrontScreen 3x3. 
 
 
 
 
 
 
 
 
 
 
• Highlight the image you require. 
 
 
 
 
 

• Click on the ¨Ok¨ button. 
 
 
 
 
 
 
 
Click on the ¨Ok¨ button. 
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Shortcut Keys 

 
The following Shortcut Keys are used in Portable Design.  Using these keys can 
significantly increase your speed in Portable Design. 
 
Function     Shortcut 
 
Keyboard 
 
 Move between fields……………… Tab  
 Finish process …………………… Enter 
 Override Angle Snapping ………… CTRL 
 Delete selected item(s)…………… DEL 
 Enable/Disable numeric keypad … NUM LOCK 

 
Mouse Controls 
 Select Single Object…………………  Left mouse button 

 Select Multiple Objects…………….. Shift + click 
 Area Select………………………….. Drag 
 Touch Select………………………… CTRL + drag 
 Position Cursor……………………… Right Mouse Button –or- 
                                                    CTRL + right mouse button 
 

Views 
 Customer Details…………………… CTRL + 0 
 Room Details………………………... CTRL + 1 
 Item List…………………………….. CTRL + 2 
 Plan………………………………….. CTRL + 3 
 …………………………….. CTRL + 4 
 Perspective………………………….. CTRL + 5 
 Report……………………………….. CTRL + 6 
 Multi View…………………………… CTRL + 7 
 Virtual Designer……………………… CTRL +8 
 
Info Palette 
 Show Info Palette…………………… CTRL + SHIFT + I 
 
Linking Palette 
 Show Linking Palette……………….. CTRL + SHIFT + L 
 
Mover Palette 
 Show Mover Palette………………… CTRL + SHIFT + M 
 Up*………………………………….. CTRL + ALT + 8 
 Left*………………………………… CTRL + ALT + 4 
 Right*……………………………….. CTRL + ALT + 6 
 Down*………………………………. CTRL + ALT + 2 
 
*Pressing the Cursor keys on the keyboard while holding down the CTRL key will 
also activate the Up, Down, Left, and Right Mover arrows. 
 
 Attach Cursor……………………….. CTRL + ALT + 5 
 Clockwise…………………………… CTRL + ALT + ] 
 Counter-clockwise………………….. CTRL + ALT + [ 
 Rotate X…………………………….. CTRL + ALT + L 
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 Rotate Y…………………………….. CTRL + ALT + ; 
 Rotate Z…………………………….. CTRL + ALT + ‘ 
 Push………………………………… Shift + CTRL + ALT + 8 
 Pull…………………………………. Shift + CTRL + ALT + 2 
 Slide Left…………………………… Shift + CTRL + ALT + 4 
 Shift Right………………………….. Shift + CTRL + ALT + 6 
 
Add Palette 
 Show Add Palette………………….. Shift + CTRL + A 
 Walls……………………………….. CTRL + ALT + W 
 Windows…………………………… CTRL + ALT + P 
 Units/Objects…………………… CTRL + ALT + U 
 Left Handing……………………….. CTRL + [ 
 Right Handing……………………… CTRL + ] 
 
Graphic Add Palette 
 Show Graphic Add Palette…………   Shift + CTRL + G 
 
View Palette 
 Show View Palette…………………. Shift + CTRL + V 
 
Dimension Palette 
 Show Dimension Palette……………. Shift + CTRL + D 
 
Tools 
 Pointer…………………………….… Shift + CTRL + 8 
 Variable Item……………………….. Shift + CTRL + 9 
 Room Outline………………………. Shift + CTRL + B 
 Poly………………………………… Shift + CTRL + 4 
 Ruler……………………………….. Shift + CTRL + 6 
 
File Menu 
 New………………………………… CTRL + N 
 Open……………………………….. CTRL + O 
 Close……………………………….. CTRL + W 
 Print………………………………… CTRL + P 
 Save………………………………… CTRL + S 
 Quit/Exit……………………………. CTRL + E 
 
Edit Menu 
 Undo……………………………….. CTRL + Z 
 Cut…………………………………. CTRL + X 
 Copy……………………………….. CTRL + C 
 Clear………………………………. DEL 
 Paste……………………………….. CTRL + V 
 Duplicate………………………….. CTRL + D 
 Select All………………………….. CTRL + A 
 
View Menu 
 Zoom In……………………………. CTRL + + (keypad) 
 Zoom Out………………………….. CTRL + - (keypad) 
 
Call Menu 

 Add Floor………………………….. CTRL + G 
 Add Ceiling………………………… CTRL + H 
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 Auto Features……………………… CTRL + K 
 Edit Worktops…………………… CTRL + J 
 
Change Menu 
 Change Default Style……………… CTRL + Q 
 Change Selection Style…………… CTRL + Shift + Q 
 Rotate Cursor By………………….. CTRL + R 
 Rotate Cursor 90°…………………. CTRL + 9 
 Change Price………………………. CTRL + = 
 Change graphics……………………… CTRL + U 
 Layers……………………………… CTRL + L 
 Catalog Info……………………….. CTRL + I 

 
 
 

 
 
 
 
 
 
 

 


